All rights reserved. No part of this manual may be reproduced or transmitted in any form or by any means including printing, photocopying, microfilm, electronic systems etc. without our prior written permission. Brand names, registered trademarks etc. used in this manual, even if not explicitly marked as such, are not to be considered unprotected by trademarks law. They are the property of their respective owner.

This manual is the original documentation for the OPUS spectroscopy software.
Table of Contents

1 Introduction ........................................................................................................... 5
  1.1 About this document ....................................................................................... 5
  1.2 How to report errors? .................................................................................... 5
  1.3 Mandatory items to be reported in any case ............................................... 5
  1.4 Further items to be reported ......................................................................... 6
  1.5 How to log errors in Windows 7 ................................................................... 6
     1.5.1 Defining WER as default program ......................................................... 7
     1.5.2 Registry parameters for global settings .................................................. 8
     1.5.3 Registry parameters for application-specific settings ............................. 10
  1.6 How to log errors in Windows XP? ............................................................... 10
     1.6.1 Defining Dr. Watson as log file standard ............................................. 11
     1.6.2 Error messages in Windows .................................................................. 11

2 Types of errors .................................................................................................... 13
  2.1 Complete operating system crash ................................................................. 13
  2.2 OPUS disappears ......................................................................................... 14
  2.3 Error message in OPUS ............................................................................... 15
     2.3.1 Error message in connection with ADIO/PROCESS ............................. 16
  2.4 OPUS interface freezes ............................................................................... 16
     2.4.1 Creating dump file for a hanging process ............................................ 17
  2.5 Windows XP .................................................................................................. 18
     2.5.1 OPUS crash ........................................................................................... 18
# Table of Contents

## 3 Error during measurement

3.1 Generating full report

3.1.1 Via the firmware page of the spectrometer

3.1.2 Via the OPUS diagnostics page

3.2 Saving the latest measuring results

## 4 Appendix

## Index
1 Introduction

1.1 About this document

In many cases problems or errors witnessed with OPUS have been accepted, and it has been tried to somehow get on with them. However, this attitude does not help to improve the general situation nor solves the specific problem.

Therefore, report any single problem, error or OPUS system crash to the Bruker Optik software department. New ideas and suggestions for improvement are also welcome.

For important information this document uses the following format:

The *i* provides important information given to the user to facilitate troubleshooting in specific application issues.

1.2 How to report errors?

- Send an e-mail to: opusbugs@bruker.com
- Use the official OPUS error form available in the intranet (only internal):
  
  `file://pia.optik.lan/Home/Groups/QM/Formblaetter/IRENS/FBSOI008.doc`

1.3 Mandatory items to be reported in any case

- Exact OPUS version with date
- Operating system version
- Detailed description of the last steps which have been done or tried to do
### 1.4 Further items to be reported

Depends on the complexity of the problem. Several different types of problems or errors are distinguished:

1. Complete operating system crash
2. OPUS crash
3. OPUS disappears
4. Error message in OPUS
5. OPUS interface freezes

The different types of problems or errors which may occur in connection with OPUS and their troubleshooting are described in chapter 2.

### 1.5 How to log errors in Windows 7

Any type of crash occurred in OPUS is generally logged by the *Windows Error Reporting* (WER) program. So-called dump files, which are more or less reports of what happened to the system at the moment before it failed, allow to save program information in the dump file, which can be useful for a later debugging. The dump file uses the *minidump* file format with the *.dmp* file extension.

If OPUS crashes and prior to its termination, the WER checks the dump file entries in the registry\(^1\) to determine whether a local dump is to be generated. In the affirmative, OPUS is terminated after the dump file has been generated.

These dumps are configured and controlled independently of the rest of the WER infrastructure. You can make use of the local dump collection even if WER is disabled or if the user cancels WER reporting. The local dump can be different to the dump sent to Microsoft.

---

1. Windows database in which all pieces of information on software and hardware are stored.
1.5.1 Defining WER as default program

Defining WER as default program for logging errors requires Administrator user rights.

1. Open the Windows Start menu.
2. Select the Run command.
3. On the dialog that opens, enter regedit.
4. Click OK to confirm.
5. Select the following path for the registry parameters:
   ➔ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error Reporting\LocalDumps
6. Enter the registry parameters described in chapter 1.5.2.
### 1.5.2 Registry parameters for global settings

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
<th>Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DumpFolder</td>
<td>The path where the dump files are to be stored. If you do not use the default path, the folder must contain ACLs that allow the crashing process to write data to the folder. For service crashes, the dump is written to service-specific profile folders depending on the service account used. For example, the profile folder for system services is: %WIN\D\IR%\Sy\st\em32\Config\SystemProfile For network and local services, the folder is: %WIN\D\IR%\Serv\iceProfiles</td>
<td>REG_EXPAND_SZ</td>
<td>%LOCAL APP- DATA%\Crash- Dumps</td>
</tr>
<tr>
<td>DumpCount</td>
<td>The maximum number of dump files in the folder. When the maximum value is exceeded, the oldest dump file in the folder is replaced by the new dump file.</td>
<td>REG_DWORD</td>
<td>10</td>
</tr>
</tbody>
</table>

Table 1.1: Registry parameters for global settings
### Registry Parameters for Global Settings

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
<th>Type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DumpType</td>
<td>Specify one of the following dump types:</td>
<td>REG_D WORD</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>• 0: Custom dump</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1: Mini dump</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 2: Full dump</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Custom-DumpFlags</td>
<td>The custom dump options to be used. This value is used only when DumpType is set to 0. The options are a bitwise combination of the MINIDUMP_TYPE enumeration values.</td>
<td>REG_D WORD</td>
<td></td>
</tr>
</tbody>
</table>

Table 1.1: Registry parameters for global settings


b. In hex, this is the value 0x121.
1.5.3 Registry parameters for application-specific settings

Application-specific registry parameters override the global settings. To create application-specific settings, you have to create a new key for your application (chapter 1.5.3.1).

1.5.3.1 Creating key

1. Open the Windows Start menu.
2. Select the Run command.
3. On the dialog that opens, enter regedit.
4. Click OK to confirm.
5. Select the following path for the registry parameters:
   ➣ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error Reporting\LocalDumps\OPUS.exe
6. Add the dump settings under the OPUS.exe key.
   ➣ If OPUS crashes, WER first reads the global settings, and then overrides any of the settings by using the application-specific settings.

1.6 How to log errors in Windows XP?

Any type of crash occurred in OPUS is generally logged by Dr Watson. In some cases, however, other Windows programs are used to log system crashes. Windows XP, e.g. can be configured such that the Windows Error Reporting (WER) program acts instead of Dr Watson.

In this case, a typical Windows error message pops up. It is possible to define Dr Watson as standard to trace errors in the form of so-called log files. The steps required are described in chapter 1.6.1.
1.6.1 Defining Dr. Watson as log file standard

1. Open the Windows Start menu.
2. Select the Run command.
3. On the dialog that opens, enter `drwtsn32 -i`.
4. Click OK to confirm.
   ➞ A message pops up. The message confirms that Dr Watson has been installed as standard program to create log files.
5. Click OK to confirm the message.

1.6.2 Error messages in Windows

1. As soon as the error message is displayed, open the error report.
   ➞ The error processing is sent to Dr Watson which generates the corresponding log files.
2. Make a screen shot of the error report contents.
3. Send the screenshot to opusbugs@bruker.com.
   ➞ Do not send the '*\acomp.txt' file to Bruker, as this file does not contain any usable data.
2 Types of errors

The following chapter describes the different types of problems or errors which may occur when working with OPUS.

2.1 Complete operating system crash

<table>
<thead>
<tr>
<th>What happens?</th>
<th>Blue screen</th>
</tr>
</thead>
</table>
| Possible cause: | • Severe problems with the operating system  
| | • Perhaps a non-conforming driver |
| What about OPUS? | OPUS probably does not cause this problem as it is a user-mode program. |
| Information on the error: | • Look at the first two lines on the screen (mainly figures).  
| | • Look at the DLL list, written right below Name.  
| | • Check drivers recently changed, or new hardware components.  
| | • Remove drivers or look for more updated ones with the vendor. |

Table 2.2: Complete operating system crash
## 2.2 OPUS disappears

| What happens? | • OPUS completely disappears from the screen.  
• Even the OPUS process disappears from the Windows Task Manager. |
| Possible cause: | • Any problem with the PC configuration  
• So-called *Silent Process Exit*:  
  - normal, *planned* (and silent) exit, due to a normally executed (yet possibly unexpected) exit request for a component used within the OPUS process  
  - abnormal exit (silent!), due to an unrecoverable multi-error problem  
• Interaction with other programs |
| Information on the error: | No information available at all, not even a message box notification. |
| What is to be done? | • Contact Bruker software department to clarify whether additional debug tools can be used.  
• Download the debugging tools for Windows (e.g. *gflags.exe*) from the following Microsoft Web site:  
  *http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx*  
• In case of Windows 7 and higher: activate the *Silent Process Exit* option; or configure an interactive debugger, e.g. via *windbg -I* |

Table 2.3: OPUS disappears
Background information: Very often the hang only occurs when the process is under load. The best approach is to attach a debugger to the process after it has hung (if you can reproduce the problem or remote debug), or create a process dump. A process dump is almost as good as a live debug in these cases, as the state does not change much over time; that is as good a definition of a hang as any other one.

Table 2.3: OPUS disappears

<table>
<thead>
<tr>
<th>What happens?</th>
<th>OPUS still runs. Error message pops up.</th>
</tr>
</thead>
</table>
| Possible cause: | • Any temporary OPUS system error  
| | • Wrong procedure sequence  
| | • Missing files or methods |
| Information on the error: | Text written in error message |
| What is to be done? | Send a screenshot of the error message to: opusbugs@bruker.com |

Table 2.4: Error message in OPUS
2.3.1  Error message in connection with ADIO/PROCESS

<table>
<thead>
<tr>
<th>What is to be done?</th>
<th>Send the ADIO/PROCESS protocol log files to <a href="mailto:opusbugs@bruker.com">opusbugs@bruker.com</a>.</th>
</tr>
</thead>
</table>
| ADIO/PROCESS log file path: | • ADIO: <OPUS\ADIO\error.log  
  • PROCESS: <OPUS\PROCESS\ProcessS-cenarioSequence.obs\error.log |

Table 2.5:  Error message in OPUS

2.4  OPUS interface freezes

<table>
<thead>
<tr>
<th>What happens?</th>
<th>OPUS does not react to any data input at all.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible cause:</td>
<td>Several actions running too fast in succession.</td>
</tr>
<tr>
<td>Information on the error:</td>
<td>No information available.</td>
</tr>
</tbody>
</table>
| What is to be done? | • Wait at least 2 minutes to reverse this hang-up. Try to minimize the window. Maximize again to see whether the spectra display has been refreshed.  
  • If the hang-up still persists, open the Windows Task Manager to have a look at the programme status. End task, if required.  
  • Send a short description of the situation to opusbugs@bruker.com. |

Table 2.6:  Error message in OPUS
2.4.1 Creating dump file for a hanging process

2.4.1.1 In case of Windows 7 (32 or 64 bit)

1. Right click the taskbar.
2. From the pop-up menu that opens, select the Start Task Manager command.
3. Click the Processes tab.
4. Right click the opus.exe file.
5. From the pop-up menu that opens, select the Create Dump File command.
6. Wait until the process is written to the dump file.
7. If the opus.DMP dump file has been created, click OK to confirm the message box.

➢ The message box shows the directory which the dump file has been saved in. Dump files have the extension '*.DMP'.

2.4.1.2 In case of Windows XP

The Userdump.exe auxiliary tool is required. Details on the Userdump.exe auxiliary tool are described in the Userdocs.doc file. The file is part of the auxiliary tool.

1. Download the Userdump.exe tool, version 8.1 (including the related documentation) from the following Microsoft Web site:


2. Start the Setup.exe program for the processor.

➢ By default, the ‘Setup.exe’ program is part of the 'Userdump.exe' tool in the 'C:\kktools\user dump8.1' folder. The 'Setup.exe' program installs a kernel-mode driver and the 'Userdump.sys' file. Additionally, the program generates the 'Process Dump' icon in the 'Control Panel'.

3. If possible, deactivate the Dump on process termination feature when the Setup.exe program runs.
4. If the program stops responding, go to the Userdump.exe tool.
5. Select the command line and enter the userdump <PID> command.
   ➣ <PID> is a placeholder for the process ID (PID) of the program that has stopped responding. To obtain the PID of the program, open the Task Manager, and click the ‘Process’ tab.
6. Start the userdump <PID> command.
   ➣ A file is generated with the ‘*.dmp’ extension.
7. Send the *.dmp file to opusbugs@bruker.com, to perform post-mortem debugging.

2.5  Windows XP

2.5.1  OPUS crash

<table>
<thead>
<tr>
<th>What happens?</th>
<th>OPUS will be closed automatically.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Possible cause:</td>
<td>Any severe OPUS system error, e.g. out of memory/resources</td>
</tr>
<tr>
<td>Information on the error:</td>
<td>Generally, Dr Watson pops up.</td>
</tr>
</tbody>
</table>

Table 2.7:  OPUS crash
2.5.1.1 How to find out the log file protocol path?

1. Open the Windows Start menu.
2. Select the Run command.
3. On the dialog that opens, enter drwtsn32.
4. Click OK to confirm.
   > A dialog opens showing the log file protocol path.
5. Click the Browse button to have the path structure displayed.
6. Click OK to confirm the settings made.
7. Send the log file to opusbugs@bruker.com.

Standard log file path:

- `<\winnt\system32\drwtsn32.log`
- `\Documents and Settings\All Users\Application Data\Microsoft\Dr Watson` (sometimes in case of recent systems)

Table 2.7: OPUS crash

To find out which log file protocol path applies for the OPUS system used (see chapter 2.5.1.1), have a look at the Dr Watson for Windows dialog.
2.5.1.2 Generating a crash dump file

Usually, it is advisable to create a crash dump file (with user.dmp as file name). This type of file is very helpful in case of troubleshooting. The file requires, however, a lot of disk space.

1. Open the Windows Start menu.
2. Select the Run command.
3. On the dialog that opens, enter drwtsn32.
4. Click OK to confirm.
5. On the dialog that opens, activate the Full option button to set the file display size.
6. Activate the Create Cash Dump File check box.
7. Send the crash dump file to opusbugs@bruker.com.
3  Error during measurement

If OPUS shuts down, or the interface freezes during measurement, a full report has to be generated (chapter 3.1), and the latest, still available measuring results have to be saved (chapter 3.2).

3.1  Generating full report

The full report is a useful fault diagnostics tool. This report provides all the necessary information about the instrument configuration and complete spectrometer status.

This report also includes error messages, internal and external data transfer as well as values of all relevant parameters. The full report is an important and - especially if a problem or failure has occurred - indispensable tool for fault diagnostics by service engineers.

3.1.1  Via the firmware page of the spectrometer

<table>
<thead>
<tr>
<th>1</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measurement Memos</strong></td>
<td><strong>Open the Web browser.</strong></td>
</tr>
<tr>
<td><strong>Measurement Status</strong></td>
<td><strong>Enter the spectrometer IP address into the address entry field.</strong></td>
</tr>
<tr>
<td><strong>Direct Command Entry</strong></td>
<td><strong>On the configuration page, click Service.</strong></td>
</tr>
<tr>
<td><strong>Messages</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Diagnostics</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Service</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Authentication</strong></td>
<td></td>
</tr>
</tbody>
</table>

Table 3.8:  Generating full report
Error during measurement 3

Save the full report immediately after a problem or failure has occurred. Otherwise, important information will be overwritten by newer entries.

## 3.1.2 Via the OPUS diagnostics page

1. On the Measure menu, select the Optics Diagnostics command.
2. On the dialog that opens, click the Send Report button.
   > The report is sent to opusreports@bruker.com.

| 2 | • Click the Full Report option.  
   ➡️ The current full report is displayed. |
|---|---|
| 3 | • On the File menu of the Web browser, click the Save as command.  
   • Use the file extension *.htm.  
   • Send the original htm file to opusbugs@bruker.com. Do not generate any screenshots or text files. |

Table 3.8: Generating full report
### 3.2 Saving the latest measuring results

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1 | • **Measurement Menus**
   | • **Measurement Status**
   | • **Direct Command Entry**
   | • **Messages**
   | • **Diagnostics**
   | • **Service**
   | • **Authentication**
|   | • Open the Web browser.
   | • Enter the spectrometer IP address into the address entry field.
   | • On the configuration page, click **Service**.

| 2 | • Click the **List of result data files** option.
   | ➣ **The measuring result list is displayed.**

| 3 | • On the **File** menu of the Web browser, click the **Save as** command.
   | • Use the file extension ***.htm**.
   | • Click the **Save** button.
   | • Send the measuring result list to **opusbugs@bruker.com**.

**Note:**
- Table 3.9: Saving the latest measuring results
Error during measurement 3
4 Appendix

The appendix contains additional information for systems with the special *WinDebug* tool installed.

1. Open the *WinDebug* tool.
2. Enter the following commands into the command line:
   - LM (Enter)
   - KV (Enter)
   - R (Enter)
   - U (Enter)
   - DB (Enter)
3. On the *Edit* menu, select the *Write Window Text to File* command.
   ➢ *A log file is created.*
4. Send the log file to *opusbugs@bruker.com*.

For further information refer to: http://support.microsoft.com/kb/892277
Index

D
Dump file ......................................................6, 17, 20

F
Firmware page.......................................................21
Full report ...............................................................21
  Generating .....................................................21, 23

M
Measuring result list .............................................23

R
Registry.....................................................................6
Registry parameters ............................................8, 10

S
System crash.........................................................13

U
User interface ........................................................16
Userdump...............................................................17

W
WER......................................................................6, 7
WinDebug...............................................................25